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About this guide 

Purpose and scope  

This guide is designed to help you get started using FoodWorks® 10 Professional for 
analysing dietary intakes, recipes and meal plans. You can also use or FoodWorks® 
Premium for dietary analysis.  

 

 

This guide assumes that you are a new user of FoodWorks, and that you are creating a 
new FoodWorks database for analysing diets, recipes, meal plans and foods. 

This guide also assumes that you have a broad knowledge of the advantages and 
limitations of computerised nutrition analysis. 

Getting more help  

We recommend that you use this booklet as a guide for getting started with FoodWorks 
Professional (or FoodWorks Premium when using it for dietary analysis). There are 
also several other ways to get help using FoodWorks, including: 

• Video tutorials and blogs on our website 

• On-line help 

To get help while using FoodWorks: On the FoodWorks Help menu, click Help 
Topics.  

• FoodWorks support site 

To search our knowledge base and to submit support requests, please go to the 
FoodWorks support site: https://support.xyris.com.au 

Related documents  

If you are using FoodWorks Premium, and you are also using it for nutrition labelling 
and product development, the following guide is helpful: 

Introduction to Nutrition Labelling with FoodWorks® 10. 

The guide is available from the FoodWorks support site. 

  

https://xyris.com.au/resources/learn-foodworks-professional/
https://support.xyris.com.au/
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Conventions  

Each step-by-step computer procedure is introduced by a mouse icon in the left margin. 

Example 

To create a new database: 

1. On the FoodWorks toolbar, click New, then click FoodWorks Database File.  

Contact details  

Telephone 

+61 7 3223 5300 
1800 875 549 

Email: info@xyris.com.au 

Web: www.xyris.com.au 

 

mailto:info@xyris.com.au
http://www.xyris.com.au/
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1. About FoodWorks  Professional 

FoodWorks Professional is established and trusted Australian software for nutrition 
professionals. It is used in a wide range of contexts including health care, sports 
nutrition, food service, nutrition research, recipe publishing and tertiary education.  

FoodWorks is used to analyse dietary intakes (such as 24-hour recalls and food diaries), 
to plan meals, to develop recipes, and to investigate the nutrient content of specific 
foods. 

Features of FoodWorks for dietary analysis  

Data entry and organisation  

Using FoodWorks, you can enter dietary intakes, meal plans, recipes and foods.  

Features for entering, editing and organising your data include: 

• Quick and easy selection of foods and quantities from the most up-to-date 
Australian food composition data 

• Full-featured editing capabilities for data entry 

• Automatic updating of dietary intakes and recipes when you change a 
food/ingredient that they contain 

• Recipes you create can be used in dietary intakes and in other recipes  

• Automatically see where else in your data a food or recipe is used 

• Easily navigate and search your data 

• Organise your work with folders 

Dynamic analyses 

Nutrient analyses are updated instantaneously and graphically as you make changes to 
your dietary intakes, meal plans and recipes. Features for nutrient analyses include: 

• Compare to Nutrient Reference Values (NRVs) including RDIs. 

• See the food patterns in your diets, recipes and meal plans. With the Xyris food 
group system, view 5 major food groups and 28 subgroups, as well as oil 
equivalents, solid fat equivalents, added sugars and alcoholic drinks.  

• Compare to custom nutrient goals. 

• Show how much of a specific nutrient is in each food/ingredient.  

Analyses include macro-nutrients, vitamins, minerals, and energy and fat ratios. 

®  
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Food composition data  

The major available food composition tables include: 

• Australia—AusFoods 2019, AusBrands 2019, Australian Food Composition 
Database (AFCD) 

• New Zealand—FOODfiles 2016 

• United States—USDA National Nutrient Database for Standard Reference 
(Release 28) 

Query the food composition data  

• Search the food composition data  

• Find foods high or low in a specific nutrient 

Data publishing, import and export  

• Publish your own food composition data for use by other FoodWorks users 

• Export your FoodWorks database to Microsoft Access to enable statistical analyses 
or to generate reports 

• Import dietary intakes, recipes and foods from other FoodWorks databases 

• Import diet diaries from our free mobile app on iOS and Android, Easy Diet Diary 
(also from Xyris Software)1 

Printing options  

• Choose the elements of a dietary intake, recipe or food to print 

• Publish via Microsoft Word for complete customisation of format and layout 

System requirements  

Windows 7, 8, 8.1 or 10; Windows Server 2008 or later 

 
1 Easy Diet Diary is a free mobile app that your clients can use to track their diet and exercise. Download Easy Diet Diary from the 

Google Play Store or the Apple App Store. 
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2. Getting started 

This chapter explains how to start and exit FoodWorks, and how to create your first 
FoodWorks database. 

Downloading and installing FoodWorks  

To download and install FoodWorks, go to www.xyris.com.au and follow the 
instructions shown.  

NOTE: The FoodWorks download and free trial 

There is a single download for all the editions of FoodWorks (Professional, 
Nutrition Labelling and Premium). For the free trial period, you have access to 
FoodWorks Premium, which combines the functionality of both FoodWorks 
Professional and FoodWorks Nutrition Labelling.  

When you purchase FoodWorks you are issued with a product key. This product key 
enables the features of the FoodWorks edition that you have purchased. 

The free trial begins when you start FoodWorks for the first time. To continue using 
FoodWorks after the free trial expires, you need to purchase FoodWorks.  

Starting FoodWorks and creating your first database  

To start FoodWorks and create a FoodWorks database for dietary analysis and meal 
planning: 

1. Click the Windows Start button.  

  



 

INTRODUCTION TO DIETARY ANALYSIS WITH FOODWORKS® 10 10 

2. Click the Windows Start button, then locate and click FoodWorks 10. 

 

3. If this is the first time you have started FoodWorks, or you are trialling FoodWorks, 
the following dialog is displayed.  

 

In the above dialog, you can start or continue the free trial. Or you can enter your 
product key. 

4. If this is the first time you have started FoodWorks, read the FoodWorks License 
Agreement. To accept and continue, click I accept.  

5. The following dialog is shown. To create a new database, click Create.  

Example 
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6. A list of different types of database is displayed.  

 

7. To see information about the choices, in the list, click a type of database—a 
description appears on the right.  

 

8. Select a type appropriate for: 

• your region (in this guide we use Australia) 

• what you want to do (Diet and Recipe Analysis) 

Then click OK. 
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NOTE: Changing these settings 

You can change or view the database settings at any time while working in 
FoodWorks: On the File menu, click Database Properties, make your changes, and 
click OK. For more information see the FoodWorks on-line help. 

The free trial begins when you start FoodWorks for the first time. To continue using 
FoodWorks after the free trial expires, you need to purchase FoodWorks.  

9. Type a name for the new database and browse to an appropriate location to save it. 

 

 

NOTE: Backing up 

It is important to choose a location where you know that your FoodWorks database 
file will be regularly backed up. See Backing up your database on page 13. 

10. Click Save. 

FoodWorks is started with your new database open. 

Closing FoodWorks  

To close FoodWorks: On the FoodWorks File menu, click Close; or click the X in the top 
right corner of the FoodWorks window. 
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3. About your FoodWorks database  

Your FoodWorks database is a repository for the work you do in FoodWorks. You store 
all the dietary intakes, recipes, foods and meal plans that you create in folders in this 
database. 

Creating a new database  

To create a new database: 

1. On the FoodWorks toolbar, click New, then click FoodWorks Database File. 

 

2. Follow the steps from 5 onwards in the procedure above Starting FoodWorks and 
creating your first database on page 9. 

The database settings  

By default, your new database is created with all the most commonly required settings 
for dietary analysis. The database settings affect, for example, the food composition data 
(food selections) available to you. 

NOTE: Viewing or changing the default database settings 

       You can change or view the database settings at any time while working in 
FoodWorks: On the File menu, click Database Properties, make your changes, and 
click OK. For more information see the FoodWorks on-line help. 

Backing up your database  

It is very important to ensure that your FoodWorks database is backed up regularly. 
Make sure it is in a location that is routinely backed up as part of your organisation’s 
standard back-up routine. If you are working in a networked environment, there are 
usually shared network drives available that are automatically backed up by your 
system administrator. In general, your FoodWorks database should be stored on one of 
these network drives.  

FoodWorks also provides a simple option for ad hoc back-ups of the currently open 
database. (Note that this procedure should not replace a systematic back-up routine.)  
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To back up your database using FoodWorks : 

1. On the FoodWorks Tools menu, click Back up Database. 

2. Select the location and name for the backup. 

3. Click Save. 

Finding your database  

Finding a recently opened database  

If FoodWorks is not yet started, to find a database that you have recently opened: When 
you start FoodWorks, look in the first dialog—the databases that you have opened 
recently are listed on the right, along with their file location. 

 

(If you select the checkbox Do not show this window again, then in the future, the last 
database you worked on is opened.) 

If FoodWorks is already running, on the File menu, click Open. A list of recently opened 
databases is shown for you to select from: 
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Viewing the location of the currently open database  

To view the location of the currently open database: On the FoodWorks File menu, click 
Database Properties. Its location is shown on the General tab.  

Moving your database  

A FoodWorks database is stored as a single file with the extension .fwb. 

To move your database: First, find its current location (see above). Then use Windows 
Explorer to move it to the correct location. Note that you need to close your FoodWorks 
database before moving it. 

About the food composition data  

FoodWorks provides several sets of food composition data, referred to as data sources. 
They provide a large number of ‘ready-made’ foods and recipes, called reference foods, 
with their nutrient composition. For example, the AFCD is supplied as a FoodWorks data 
source. You select foods from the data sources when entering foods into a dietary intake 
or ingredients into a recipe.  

These data sources are not stored in your FoodWorks database but are associated with 
the database.  

By default, when you create a database, certain data sources will be enabled.  

You can view the data sources selected for your database: On the File menu, click 
Database Properties, then click Food Selections. 

For detail on a particular data source, under Data Sources, select the data source and 
information is shown on the right. You can also find information about the major food 
composition data sources supplied with FoodWorks on the support site 
https://support.xyris.com.au. 

You can explore the reference foods in the Query view. See 10. Exploring the reference 
foods on page 62.  

NOTE: Nutrient data for brand name foods (AusBrands) 

You can control the nutrient data displayed for commercial products our data 
source AusBrands 2019. You can choose whether the data is sourced from the 
nutrition information panel on the package only, imputed from AusFoods 2019, 
or taken from a mixture of these. To see or change these options, on the File 
menu, click Database Properties then the Advanced tab. 

 

 

https://support.xyris.com.au/
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4. Exploring the FoodWorks window 

The FoodWorks application window is opened when you start FoodWorks. The 
FoodWorks window provides a view into your FoodWorks database. 

Elements of the FoodWorks window  

The FoodWorks window shows: 

• the contents of your database—its folders and documents 

• the open document, for example, a food record or a recipe 

• the analyses of the open document 

The name of the open database is displayed at the top of the FoodWorks window.  

The major elements of the FoodWorks window are labelled in Figure 1—The FoodWorks 
Window.  

Figure 1—The FoodWorks Window 

 

 

Each part of the window is described below. 

The FoodWorks 

toolbar.  

B The open document 

displays the selected 

food record, 24-hour 

recall, recipe or food as 

a series of tabbed 

pages. 

Click the tabs to view or 

edit information in the 

document. 

E. Status bar  

A. The Navigation 

Pane displays all the 

folders and 

documents in your 

database.  

The documents in the 

selected folder – in this 

case, some food 

records. 

Click a document here 

to open it in the middle 

of the window. 

C. The Analysis 

Pane shows 

analyses for the 

open document. 

 

B. Name - and 

folder - of the 

open document  

Name of the 

open database.  

Your FoodWorks 

folders. Click a 

folder to open it 

and display its 

contents below. 

D. FoodWorks 

toolbar. 

The foods/ingredients 

grid  (shown here) is 

displayed on the Foods 

or Ingredients tab. This 

is where you enter the 

foods (for a dietary 

intake or meal plan) or 

the ingredients (for a 

recipe). 
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A. Navigation Pane  

The Navigation Pane is displayed down the left side of the FoodWorks window.  See 
Figure 1 on page 16. It shows you all the folders and documents within your database.  

To open a folder or document: Click the name of a folder or document in the Navigation 
Pane. 

To show all the documents in the database: Click All Folders. 

To show or hide the Navigation Pane: On the View menu, click Navigation Pane, or 
press F6.  

To resize the Navigation Pane: Point to the right-hand border until the pointer turns 
into the resize pointer, then drag to the new position.  

 

To search for one of your documents, click All Folders, then in the Search box type part 
of the name of the document. 

What is a document? 

The documents in your database are shown in the Navigation Pane. Every item that you 
create in FoodWorks is a FoodWorks document. Each document has its own icon, as 
shown below. You can organise your documents into folders.  

The default documents that you can create in a dietary analysis database are: 

Icon Document  Usage 

 

(plate) 

Food 

Record 

A document for recording an individual’s food intake. Use for recording dietary 

intakes that are over several days. 

 

(plate) 

24 Hour 

Recall 

 

A document for recording an individual’s food intake. Use for recording dietary 

intakes that are for just one continuous 24-hour period. Can also be used to plan 

meals. 

 

(plate) 

Meal Plan A document for planning an individual’s food intake. 

 

(bowl) 

Recipe Use for recipes with ingredients. 

 

(yellow pear) 

Food 

 

Use for foods that you need to add to the database. 

Contrast documents with reference foods—see About the food composition data on 
page 15. 

Resize pointer 
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NOTE: Document templates 

You can add to or modify the types of documents available to you. Each document is 
based on an underlying document template. You can add new templates and modify 
the default templates for a database. When you modify a template, documents in the 
database that are based on that template may also be changed. For how to modify 
templates, or create new templates, see the FoodWorks on-line help. 

B. Open document  

The middle of the FoodWorks window displays the currently open document with its 
name at the top. See Figure 1 on page 16. Only one document is open at any time. Each 
document is displayed as a set of tabbed pages. You click a tab to view a page. 

Foods/ingredients grid  

The foods/ingredients grid is shown on the Foods or Ingredients tab of the open 
document. Here is where you enter meals, foods and quantities for a dietary intake or 
ingredients and quantities for a recipe.  

Food selection l ist  

You select foods or ingredients from the drop-down food selection list. An example of 
the food selection list is shown in Figure 2 below. 

The food selection list appears when you begin typing a food or ingredient into the 
Foods or Ingredients column of the grid. Or you can display it at any time by clicking in 
the Food/Ingredient column and pressing F2. 

Figure 2—The Foods/Ingredients grid showing food selection list  

 

The Foods tab. 

The food selection list. 
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The foods shown in the food selection list can include: 

• reference foods from the data sources selected for this database (as in the example 
above) 

• documents (foods and recipes) from your own database. 

What is a reference food? 

Reference foods are from the data sources (food composition tables) supplied with 
FoodWorks. They are referred to as reference foods to distinguish them from the foods 
that you create and add to your database.  

Icon Item Usage 

 

(pear on page) 

Reference 

food from 

data 

source 

Select reference foods to enter into your dietary intakes and recipes. Reference 

foods have nutrient values provided. They are not FoodWorks documents—you 

cannot open and modify them. 

You can explore the reference foods in the Query view. See 10. Exploring the reference 
foods on page 62. 

C. Analysis Pane 

The Analysis Pane is displayed down the right side of the FoodWorks window. It shows 
analyses of the currently open document. 

To show or hide the Analysis Pane: On the View menu, click Analysis Pane; or press F8; 
or on the FoodWorks toolbar, click the Analyses button: 

 

To resize the Analysis Pane: Point to the left border until the pointer turns into the 
resize pointer, then drag to the new position. 

 
Resize pointer 

Analyses button 
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If the Analysis Pane is wide, to select the type of analysis you want to view: Click an 
analysis in the list on the left.  

 

 

If the Analysis Pane is narrow, to select the type of analysis you want to view: Click the 
down arrow, then click an analysis in the drop-down list.  

 

Wide Analysis Pane… 

  

Narrow Analysis Pane  

… showing the  list of analyses as 

a drop-down. Click the down arrow 

to show the list…  

 

 

… showing the list of analyses 

down the left. Click an analysis to 

select it. 

  

…then click an analysis to select it.  
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D. Toolbar  

The FoodWorks toolbar is shown across the top of the FoodWorks window and 
provides short-cuts for commonly used commands. 

 

To see the name of a button in the toolbar, hover your cursor over the button. 

E. Status bar  

The status bar is shown along the bottom of the FoodWorks window. 

To show or hide the toolbar or status bar: On the View menu, click Status Bar or 
Toolbar. 

Orientation exercise  

Try this quick orientation exercise to become more familiar with the elements of the 
FoodWorks window: 

1. Start FoodWorks. 

2. Click the Windows Start button, then locate and click FoodWorks 9. 

3. Click a recently opened database. 

When you first open FoodWorks, a blank document is opened. 

 

NOTE: Sample FoodWorks database  

To help you explore FoodWorks, we have provided a sample dietary analysis 
database, populated with some food records and recipes. To open this database, on 
the Help menu, click Open Sample Database, then Sample Pro Database. 

Try hiding and then showing the Navigation Pane  

1. On the View menu, click Navigation Pane. Repeat to show/hide it again. Try using 
the shortcut key (F6).  

2. Explore the options in the open document. Click each of the tabs—for example, for a 
recipe, click the Ingredients tab, the Overrides tab, and so on.  

Save the open 

document. 

Open the 

Graphs  

window 

View the 

analyses 

Print the 

selected 

sections  of 

the document 

Open a 

document or 

database 

Open the 

Query view of 

your 

Previous and 

next documents 

Create a new 

document or 

database 

Access 

the 

help 

option

View the 

tools 

options 

View the  

Foods/ingredients  

tree for this  

document 
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Explore the options with the Analysis Pane  

1. Try hiding and then showing the Analysis Pane. On the View menu, click Analysis 
Pane. Repeat to show/hide it again. Try using the shortcut key (F8).  

2. Try resizing the Analysis Pane to show the wide view – in the list of analyses on the 
left, click an analysis to display it.  

3. Then resize the Analysis pane to show the narrow view. Click the down arrow, then 
from the drop-down list, click an analysis to display it. 

Explore the help  

1. In FoodWorks, on the Help menu, click Help Topics. 

2. If necessary, to show the help menu, click the Menu button.   

3. To browse the help using the table of contents, click the Contents tab. Then click a 
book, and then a topic, to open it. 

4. To look up the index, click the Index tab, type a search term. Then click a topic in the 
search results. 

5. To search the help text as a whole, in the Search box, type a search term and press 
Enter. Then click a topic in the search results. 

Close FoodWorks  

• On the FoodWorks File menu, click Close—or click the black X at the top right of the 
FoodWorks window. 
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5. Entering dietary intakes and meal plans 

This chapter explains how to record a dietary intake (sometimes called a diet or food 
diary) or a meal plan for an individual. In FoodWorks, there are two types of document 
you can use for a dietary intake—one for multiple days, called a food record, and one 
for a single day, called a 24 hour recall. 

Icon in 

FoodWorks 

Document Usage 

 

(plate) 

Food Record A FoodWorks document for recording an individual’s food intake over several days.  

 

(plate) 

24 Hour Recall 

 

A FoodWorks document for recording and individual’s food intake for just one 

continuous 24-hour period.  

 

(plate) 

Meal Plan A FoodWorks document for planning an individual’s food intake for one or more 

days. 

 

NOTE: Food frequencies 

You can also enter food frequencies into a dietary intake. See the FoodWorks on-
line help. 

Food records, 24 hour recalls, and meal plans are FoodWorks documents and are stored 
in your FoodWorks database. For more on FoodWorks documents see What is a 
document? on page 17. 

When adding either any of these documents, you need the following information: 

• The personal details of the individual—such as age, weight, gender and activity level 

• All the foods and drinks, and their quantities, consumed by this person in a 24 hour 
period or over a number of days 
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Entering a food record, 24 hour recall or meal plan  

To enter a food record or 24 hour recall: 

A. Create the new food record, 24 hour recall  or meal plan  

First, create the new food record, 24 hour recall or meal plan: 

1. On the FoodWorks toolbar, click New, then click Food Record, 24 Hour Recall or 
Meal Plan. 

Example (24 Hour Recall) 

 

2. On the General tab, in the Name box, type the name for the food record or 24 hour 
recall. 

Example (24 Hour Recall) 

 

3. Optionally, enter the ID for the food record, 24 hour recall or meal plan. 
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4. Click the Folder drop-down button and select the folder in which you want to store 
the food record, 24 hour recall or meal plan. By default, there is one folder called 
Documents. 

Example (24 Hour Recall) 

  

5. If you want to create a new folder, click the ellipsis (…) button, type the folder name, 
and click OK. 

 

6. On the toolbar, click the Save button. 

 

B. Enter the personal details  

The individual’s personal details are required for FoodWorks to calculate the Nutrient 
Reference Values (NRVs). They are also necessary for FoodWorks to calculate their 
Basal Metabolic Rate (BMR) and the Body Mass Index (BMI), which are displayed on the 
General tab. 

To enter the personal details: 

1. Type in the age of the person. 

2. Click the drop-down button to select their gender. 

3. Type in their weight and height.  

4. Click the drop-down button to select their level of activity. For help in choosing the 
appropriate activity level, click the ellipsis (....) button. 

 

5. If the subject is female, enter her pregnancy and lactation status. 

You can now see the values for the BMI, EER and BMR on this tab. 
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C. Enter the foods  

To enter all the foods and drinks that the person has consumed: 

1. Click the Foods tab. 

Foods grid (24 Hour recall) 

 

The only difference between a 24 hour recall document and a food record is here in 
the Foods tab—for a food record, there is an extra column, the Day column. 

TIP: Showing the Day or Meal column 

        If the Day or Meal column is not showing, and you wish to show one or both: 
Point to the title of any column in the grid. Right-click, then select the name of the 
columns to show.  

 

  

The Foods grid for 24 hour 

recalls. (Food records and 

meal plans include a Day 

column.) 

The Meal column. 

The Food column. 

The Quantity column. 
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2. If this is a food record or meal plan, in the Day column, type the name of the first 
day; or, to select the date, click in the Day cell, press F2, then click the date.  

Example (food record) 

 

 

TIP: Collapsing and expanding days or meals 

In food records, 24 hour recalls and meal plans, you can expand and collapse 
meals and days: 

            To expand a day or meal, click the + (plus) sign.  

             To collapse a day or meal, click the - (minus) sign.  

Example 

  

Click the Outline button, as shown below, for more options: 

 

 

Click  the + (plus) sign to 

show all the meals and foods 

for 1 Jan. 

Click any – (minus) sign to 

collapse the day or meal. 



 

INTRODUCTION TO DIETARY ANALYSIS WITH FOODWORKS® 10 28 

TIP: Entering data 

When entering a food record, 24 hour recall or meal plan, you use a separate row 
for each day, meal and food. 

 

3. In the Meal column, type the name or time of the first meal, then press Enter. 

Example (24 Hour Recall) 

 

4. In the Food column, type the first few letters of each word of the food. Use the 
arrow keys to select the food from the drop-down list box, then press Enter. A list of 
matching foods (the food selection list) is shown. 

Example (24 Hour Recall) showing the food selection list 

 

 

TIP: Finding foods 

For more on what to type to find foods more efficiently, see Tips for finding foods 
and ingredients faster on page 31.  

 

The food selection list. To 

show it at any time, click in 

the Food column and press 

F2. 
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TIP: See where a food comes from 

The food selection list can contain items from several different sources, including 
data sources and your database folders.  

         To see the source of a particular food or recipe in the food selection list: 

In the list, highlight the item. The source (a data source or folder) is shown at the 
bottom of the list.  

 

 

For more on FoodWorks data sources, see About the food composition data on 
page 15. 

 

Click a food in the food 

selection list to show its 

source. 

The source of the 

highlighted food is shown 

at the bottom of the food 

selection list. Here it is the 

AusFoods data source. 
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TIP: Can’t find the recipe or food you want? Create one on the fly. 

If you cannot find the recipe or food that you want, you can create it while 
entering foods into the Foods grid of the dietary intake, and enter its details later: 

          To create a new recipe or food while in the Foods grid: In the Food column, 
type the name of the new recipe or food, or simply type new recipe or new food. 
Then type its name, select the required folder, and click OK.  

 

This creates an ‘empty’ recipe or food document (with no nutrient values) that 
you can fill in later. See 7. Adding a recipe on page 42 and 9. Adding a new food on 
page 57. 

(Note that you cannot create new documents on the fly if you have keywords 
switched on—see B. Using keywords for selecting foods on page 78.) 

5. In the Quantity column, type the number of units for the measure that you want to 
use. Then press Enter. 

Example (24 Hour Recall) 

 

NOTE: Fractions 

To enter a fraction, use decimals—for example, for ½ type 0.5. 

6. Use the arrow keys to select the measure that you want to use or type the first few 
letters of the measure name. Then press Enter. 
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7. Repeat steps 4 to 6 for each food in the meal.  

8. Repeat from step 3 to start the next meal. 

9. Repeat from step 2 to start the next day. 

TIP: Decided you want to enter more days than one? 

If you have entered a day’s worth of food and drink into a 24 hour recall and 
realise that you want to continue on to more days, add a Day column: see TIP: 
Showing the Day or Meal column on page 26. 

D. Save the food record, 24 hour recall  or meal plan  

To save: On the FoodWorks toolbar, click Save. 

 

 

Tips for finding foods and ingredients faster 

When you are entering foods into the Foods tab of a food record, 24 hour recall or 
meal plan (or into the Ingredients tab of a recipe) try these tips for finding them 
faster: 

• Type two to four letters only per key word of the ingredient name. This is faster 
and helps avoid spelling mistakes—for example, avo finds avocado. Typing 
avocado does not refine this search any further.  

• Typing the first part of two or more key words helps refine your search—for 
example, for black tea, type bl tea rather than tea.  

• The order for typing key words does not alter the number of foods found—for 
example, tea black is identical to black tea.  

• Case is unimportant. FoodWorks accepts upper-case and lower-case entries.  

• Type the singular for foods—for example, type pea, not peas, bean not beans. 

• If you do not find the food, try alternative spellings or other word combinations.  

• For some foods, there are many different varieties. Hence, when the varieties are 
displayed that may not all fit on to the screen. Use the arrow key to scroll down 
and see more varieties.  

Next steps  

This dietary intake is shown in the Navigation Pane of FoodWorks. 

The next chapter explains how to view the nutrient analyses for your food record or 24 
hour recall. Chapter 7. Adding a recipe and Chapter 9. Adding a new food explain how to 
add recipes and foods you need to your database.  



 

INTRODUCTION TO DIETARY ANALYSIS WITH FOODWORKS® 10 32 

6. Analysing dietary intakes and meal plans 

While you are entering your food record, 24 hour recall or meal plan, you can view its 
analyses in the Analysis Pane on the right of the FoodWorks window. The analyses 
update as you make changes. Here are some suggestions for exploring the nutrient 
analyses for a dietary intake. 

Basics—Using the Analysis Pane  

To view the analyses for the food record, 24 hour recall or meal plan: 

1. First open that food record, 24 hour recall or meal plan: In the Navigation Pane, click 
the document.  

2. To show the Analysis Pane (if it is not already displayed), on the FoodWorks toolbar, 
click the View Analyses button.  

 

3. To choose the unit of analysis for the food record, 24 hour recall or meal plan: Click 
the tabs at the top of the Analysis Pane. You can look at the analyses as an average 
per day or per megajoule.  

  

View Analyses button 

Click the tab for the unit of analysis 

for the food record or 24 hour recall. 



 

INTRODUCTION TO DIETARY ANALYSIS WITH FOODWORKS® 10  33 

4. Then, in the list of analyses, click the analysis you require (e.g. General): 

If the Analysis Pane is wide, the analyses are listed down the left of the pane.  

 

If the Analysis Pane is narrow, the analyses are shown as a drop-down list. Click the 
down arrow to display the list.  

 

NOTE: Question marks (?) and ‘greater than’ (>) signs in the analyses 

For help with resolving these problems see A. Symbols in the analyses on page 75. 

When the Analysis Pane is wide, the 

list of analyses is shown on the left. 

Click the analysis you require.  

When the Analysis Pane is narrow, 

the list of analyses is shown as a 

drop-down. Click the analysis you 

require. 
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About the nutrient reference values (NRVs)  

The nutrient reference values (NRVs) for use in Australia and New Zealand2 outline the 
levels of intake of essential nutrients to meet the known nutritional needs of practically 
all healthy people. They may not meet the specific requirements of people with various 
diseases or conditions, or pre-term infants. 

In the Analysis Pane of FoodWorks, you can view NRV analyses as shown in Figure 3—
The NRV analyses in FoodWorks below: 

Figure 3—The NRV analyses in FoodWorks 

 

 

  

Here are the definitions for each NRV that appears in FoodWorks: 

Estimated Energy Requirements (EER)—The average dietary energy intake that is 
predicted to maintain energy balance in a healthy adult of defined age, gender, weight, 
height and level of physical activity, consistent with good health. In children and 
pregnant and lactating women, the EER is taken to include the needs associated with the 
deposition of tissues or the secretion of milk at rates consistent with good health. 

Estimated Average Requirement (EAR)—A daily nutrient level estimated to meet the 
requirements of half the healthy individuals in a particular life stage and gender group. 

Adequate Intake (AI)—The average daily nutrient intake level based on observed or 
experimentally determined approximations or estimates of nutrient intake by a group 

 
2 National Health and Medical Research Council (NHMRC) (2006). Nutrient reference values in Australia and New Zealand. 

Executive summary. Canberra:NHMRC 

The red indicates potential problems 

with the nutrient level being under or 

over the suggested level. 

EER,EAR,AI,UL analyses SDT analysis 

 

RDI analysis 
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(or groups) of apparently healthy people that are assumed to be adequate. It is used 
when an RDI cannot be determined. 

Upper Level of Intake (UL)—The highest average daily nutrient intake level likely to 
pose no adverse health effects to almost all individuals in the general population. As 
intake increases above the UL, the potential risk of adverse effects increases. 

Suggested Dietary Target (SDT)—A daily average intake for certain nutrients that 
may help in the prevention of chronic disease. These values apply only to adults and 
adolescents aged 14 years and over. 

Recommended Dietary Intake (RDI)—The average daily dietary intake level that is 
sufficient to meet the nutrient requirements of nearly all (97–98 per cent) healthy 
individuals in a particular life stage and gender group. 

About the food groups  

The Xyris food group system allows you to analyse diets, recipes and meal plans by food 
group, and thus investigate food patterns.  

The food groups use Australian food composition data, including extensive brand name 
data, and are informed by the Australian Guide to Healthy Eating (AGHE)3, and the 
USDA Food Patterns Equivalents Database (FPED)4.  

The Xyris food groups are broadly compatible with the five food groups (and additional 
categories) of the Australian Guide to Healthy Eating. However, there are important 
differences. 

Food groups and serve sizes  

There are 5 major food groups and 28 subgroups, as well as oil equivalents, solid fat 
equivalents, added sugars and alcoholic drinks. 

See the number of serves of the basic food groups (e.g. vegetables) and drill down into 
the subgroups (e.g. dark green vegetables). Where a recipe is available for them, 
composite foods and recipes (e.g. donuts, lasagne) are allocated to food groups 
according to their ingredients. 

Serve sizes for the food groups are similar to those in the AGHE.  

 

 
3 https://www.eatforhealth.gov.au/guidelines/australian-guide-healthy-eating 

 
4 http://www.ars.usda.gov 

 

TIP: More on NRVs? 

For more information go to www.nrv.gov.au. 

NOTE: Food groups are only for Australian data 

The food group analyses are only available if you are selecting food from these 
Australian data sources: AUSNUT 2011-13, AusFoods 2019 and AusBrands 2019. 

http://www.ars.usda.gov/Services/docs.htm?docid=23871
https://www.eatforhealth.gov.au/guidelines/australian-guide-healthy-eating
http://www.ars.usda.gov/
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Discretionary choices and food components  

In the Xyris food groups, some food components are treated as ‘groups’ in their own 
right, namely: 

• Oil equivalents (fats naturally occurring in nuts, seeds, avocado, seafoods, and un-
hydrogenated vegetable oils; excludes palm oil and coconut oil) 

• Solid fat equivalents (fats naturally occurring in meat, poultry, eggs, dairy, fully or 
partially hydrogenated oils, shortening, palm oil and coconut oil) 

• Added sugars 

• Alcoholic drinks 

As a result, the ‘discretionary choices’ category used in the AGHE is not used in the Xyris 
groups. Instead, all composite foods, including those that would be discretionary items 
(e.g. pizzas, pastries, commercial burgers), are broken into their 
ingredients/components and assigned to 'groups' accordingly. The resulting analysis 
exposes teaspoons of solid fat equivalents and added sugars, and serves of refined 
grains, etc. For example, a meat pie which would be considered a discretionary choice in 
the AGHE, in the Xyris system would instead contribute serves of meat, refined grains, 
solid fats, and so on. 

More information on food groups in FoodWorks  

For more information on the food groups and serve sizes, see the FoodWorks support 
site, https://support.xyris.com.au 

Viewing the food groups analyses  

To view the food groups analyses for your diet, recipe or meal plan: 

• In the Analysis Pane, in the list of analyses, click Food Groups. 

 

  

Click Food Groups. 

https://support.xyris.com.au/
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Customising the nutrient profile  

You can create your own customised list of the nutrients of interest to you by editing the 
Profile analysis. 

To add or delete nutrients from the Profile analysis: 

1. If the Analysis Pane is wide: In the list of analyses on the left, click Profile, then click 
the Edit Profile button. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

- OR - 

If the Analysis Pane is narrow: Point over the Analysis Pane, click right, then click 
Edit Profile Nutrients.  
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2. Select or de-select nutrients as required.  

 

3. Click OK.  
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Investigating a particular nutrient  

To see more information for a nutrient: 

1. Make sure the Analysis Pane is wide, that is, showing the list of analyses on the left. 
For how to resize the Analysis Pane, see C. Analysis Pane on page 19.  

2. Then, in the Analysis Pane, click the nutrient name. Some information appears on 
the left of the Analysis Pane, and a new column appears in the foods grid. 

 Example—Clicking protein – information in the Analysis Pane 

  

A column for that nutrient is then also shown in the foods grid.  

Example—Clicking protein – Nutrient column in the foods grid 

 

...The nutrient column for the 

selected nutrient is displayed 

here, on the right side of the 

foods grid. 

 

Click a nutrient—here Protein... 

Click the nutrient of 

interest—here Protein... 

...and information about it is shown 

here. 
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Viewing analyses for a selection  

To see the nutrient values for part of the dietary intake only—say, for a single food or 
recipe, or for a meal: 

• Use the selector buttons on the left of the Foods grid to select the row(s). The 
Analysis Pane then shows the analyses for the selected row(s) only. 

National Health and Medical Research Council (NHMRC). (2006). Nutrient reference 

Exploring the nested recipes in a dietary intake  

A food record or 24 hour recall can include recipes from your own database. These 
recipes have ingredients of their own, which in turn might be recipes with their own 
ingredients, and so on. 

To see all the nested recipes and their ingredients in a food record or 24 hour recall (in 
a tree-like view): 

1. In the Navigation Pane, select the food record or 24 hour recall.  

2. On the toolbar, click the View Food/Ingredient Tree button. 

 

Click (and drag on) the selector 

buttons to select a row(s)...  

 

...The Analysis Pane 

then shows the 

values for the 

selected row(s) only—

in this case, for 

breakfast. 

View Food/Ingredient Tree button 
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The Food/Ingredient Tree dialog is displayed. 

Example 

 

3. To open a FoodWorks document from the Food/Ingredient Tree dialog, double-
click its name. (Remember the icons show whether each ingredient is a reference 
food from the data sources, which cannot be opened, or a FoodWorks document—
one of your own recipes or foods.) 

4. To view the values for a specific nutrient in the Food/Ingredient Tree dialog: In 
the Analysis Pane, click that nutrient. 

 

Example 

 

You can double-click a 

FoodWorks food or recipe to 

open it in the main window. 

 

Select a nutrient—here  

Saturated fat — in the 

Analysis Pane... 

 

...This column appears in 

the Food/Ingredient Tree 

showing the nutrient per 

item. 

 

You cannot open a 

reference food. 
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7. Adding a recipe 

This chapter explains how to add a recipe to your FoodWorks database. You can use the 
recipes you create as ingredients in other recipes. You can also use them as foods in 
your food records and 24 hour recalls. 

Icon Document Usage 

 

(bowl) 

Recipe Use to create recipes with ingredients. 

The key difference between a recipe and a food document in FoodWorks is that a recipe 
has ingredients. (For how to add a food, see 9. Adding a new food on page 57.) 

Recipes are FoodWorks documents and are stored in your FoodWorks database. You 
open them from the Navigation Pane. For more on FoodWorks documents, see What is a 
document? on page 17. 

When adding a recipe, you need the following information: 

• The ingredients and their quantities 

• Optionally, the number of serves it makes or the serve weight 

• Optionally, the yield 

If you wish, you can record the method (preparation instructions) for the recipe, 
however, this does not affect the nutrient analyses. 

Adding a recipe  

To add a recipe to your FoodWorks database: 

A. Create the new recipe  

To create a new recipe: 

1. On the FoodWorks toolbar, click New, then click Recipe. 
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2. On the General tab, in the Name box, type the name for the recipe. 

 

3. Optionally, enter your ID for the recipe. 

4. Click the Folder drop-down button and select the folder in which you want to store 
the food. By default, there is one folder, Documents. 

  

If you want to create a new folder, click the ellipsis (…) button, type the folder name, 
and click OK. 

 

5. On the toolbar, click the Save button. 
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B. Enter the ingredients for the recipe  

To enter the ingredients for the recipe: 

1. Click the Ingredients tab.  

Example Ingredients grid 

 

2. In the Ingredient column, type the first few letters of each word of the ingredient. 
Use the arrow keys to select the ingredient from the drop-down list box, then press 
Enter. A list of matching foods (the food selection list) is shown. 

Example recipe showing the food selection list  

 

TIP: Finding foods 

For more on what to type to find foods more efficiently, see Tips for finding foods 
and ingredients faster on page 31. 

 

The Ingredients grid for a 

recipe.  

The Ingredient column. 

The Quantity column. 

The food selection list. To 

show it at any time, click in 

the Ingredient column and 

press F2. 
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TIP: See where an ingredient comes from 

The food selection list can contain items from several different sources, including 
data sources and your database folders.  

         To see the source of a particular food or recipe in the food selection list: 

In the list, highlight the item. The source (a data source or folder) is shown at the 
bottom of the list.  

  

For more on FoodWorks data sources, see About the food composition data on 
page 15.  

 

The source of the 

highlighted food is shown 

at the bottom of the food 

selection list. Here it is—in 

this case, the AusFoods 

data source. 

Click a food in the food 

selection list to show its 

source. 
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TIP: Can’t find the ingredient you want? Create one on the fly. 

If you cannot find the food or recipe that you want as an ingredient, you can 
create while entering ingredients into the Ingredients grid, and enter its details 
later: 

          To create a new food or recipe while in the Ingredients grid entering 
ingredients: In the Ingredient column, type the name of the new ingredient, or 
simply type new recipe or new food. Then type the name for the recipe or food, 
select the required folder, and click OK. (Note that you cannot create new 
documents on the fly if you have keywords switched on – see Using keywords on 
page 78.) 

 

This creates an ‘empty’ recipe or food document that you can fill in later. Use this 
chapter to fill in the detail later for a recipe and for a food, see 9. Adding a new 
food on page 57.  

 

3. In the Quantity column, type the value (a number) for the measure that you want to 
use. A drop-down list displays the available measures for this item. 

Example 

 

 

NOTE: Fractions 

To enter a fraction, use decimals—for example, for ½ type 0.5. 

4. Use the arrow keys to select the measure that you want to use or type the first few 
letters of the measure name. Then press Enter.  

5. Repeat these steps for each ingredient in the recipe. 
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C. Enter the serve weight for the recipe  

To enter the serve weight (in grams): 

• On the Ingredients tab, in the Serve Weight(g) box (at the bottom of the 
Ingredients grid), enter the serve weight.  

 

NOTE: Number of Serves versus Serve Weight 

Click the button to toggle between Serve Weight(g) and Number of Serves and 
enter whichever value is more convenient. 

D. Enter the yield for the recipe  

If the processing step for this recipe will result in a change in weight due to the loss or 
gain of water, then you need to set the yield. 

To set the yield: 

• If you already know the final percentage weight of the recipe, on the Ingredients 
tab, in the Yield box, type the percentage. 

• If you know the final weight of the recipe, FoodWorks can calculate the yield for you. 
To enter the final weight, click the ellipsis (...) button, type in the final weight, then 
click OK. 

 
Click the ellipsis button to enter the final weight.  
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E. If  the recipe is a beverage or l iquid  

If the recipe is a beverage or a liquid: 

1. Click the Measures tab. 

 

2. Set the density by entering a volume (in mL) and its corresponding weight (in g). 

3. Select the Liquid check box. 

F. Save the recipe  

To save the recipe: On the FoodWorks toolbar, click Save. 

Next steps  

Your recipe is shown in the Navigation Pane of FoodWorks. And it is also automatically 
listed in the food selection list for you to select as an ingredient in other recipes or as a 
food in a dietary intakes. 

The next chapter explains how to view the nutrient analyses for the recipe. 
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8. Analysing a recipe 

While you are creating a recipe, you can view its nutrient analyses in the Analysis Pane 
on the right of the FoodWorks window. The analyses update automatically as you make 
changes to the recipe. Here are some suggestions for exploring the nutrient analyses for 
a recipe. 

Basics—Using the Analysis Pane  

To view the analyses for a recipe: 

1. First open the recipe: In the Navigation Pane, click the recipe. 

2. To show the Analysis Pane (if it is not already displayed), on the FoodWorks 
toolbar: Click the View Analyses button.  

  

3. To choose the unit of analysis for the recipe: Click the tabs at the top of the Analysis 
Pane. For a recipe, you can look at the analyses per 100g, per megajoule, and for 
the total recipe.  

  

If you have entered the number of serves the recipe makes at the bottom of the 
Ingredients tab, then a per Serve tab is also shown.  

 

View Analyses button 

Click the tab for the unit of analysis 

for the recipe. 
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4. Then, in the list of analyses, click the analysis you require (e.g. General): 

If the Analysis Pane is wide, the analyses are listed down the left of the pane. 

 

If the Analysis Pane is narrow, the analyses are shown as a drop-down list. Click 
the down arrow to display the list.  

 

 

NOTE: Question marks (?) and ‘greater than’ (>) signs in the analyses 

For help with resolving these problems see A. Symbols in the analyses on page 75. 

When the Analysis Pane is wide, the 

list of analyses is shown on the left. 

Click the analysis you require.  

When the Analysis Pane is narrow, 

the list of analyses is shown as a 

drop-down. Click the analysis you 

require. 
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Customising the nutrient profile  

You can create your own customised list of the nutrients of interest to you by editing the 
Profile analysis. 

To add or delete nutrients from the Profile analysis: 

1. If the Analysis Pane is wide: In the list of analyses on the left, click Profile, then click 
the Edit Profile button. 

 

- OR - 

If the Analysis Pane is narrow: Point over the Analysis Pane, click right, then click 
Edit Profile Nutrients. 
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1. Select or de-select nutrients as required. 

 

2. Click OK. 
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Investigating a particular nutrient  

To see more information for a nutrient: 

1. Make sure the Analysis Pane is wide, that is, showing the list of analyses on the left. 
For how to resize the Analysis Pane, see C. Analysis Pane on page 19.  

2. Then, in the Analysis Pane, click the nutrient name. Some information appears on 
the left of the Analysis Pane, and a new column appears in the ingredients grid. 

 Example—Clicking Protein - information in the Analysis Pane 

 

A column for that nutrient is then also shown in the ingredients grid.  

Example—Clicking Protein – Nutrient column in the ingredients grid

 

 

…The nutrient column for the 

selected nutrient is displayed 

here, on the right side of the 

ingredients grid. 

 

 

Click the nutrient of 

interest—here Protein... 

Point to a nutrient—here Protein... 

...and information about it is shown 

here. 
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Viewing analyses for a selection  

To see the values for an ingredient (or several ingredients) only: 

• Use the white selector buttons on the left side of the Ingredients grid to select the 
row(s). The Analysis Pane then shows the analyses for the row(s) only. 

 

Exploring the nested recipes in a recipe  

A recipe can include other recipes with their own ingredients.  

To see all the nested ingredients of a recipe in a tree-like view: 

1. In the Navigation Pane, select the recipe. 

2. On the toolbar, click the View food/Ingredient tree button. 

 

The Food/Ingredient Tree dialog is displayed. 

Example 

 

 

3. To open a FoodWorks document from this Food/Ingredient Tree dialog, double-
click its name. (Remember, the icons show whether each ingredient is a reference 
food, or a FoodWorks document—one of your own recipes or foods.) 

You can double-click on any FoodWorks 

document (recipe or food) to open it. 

Click the grey selector buttons 

to select a row(s), here 

coconut...  

 

...The Analysis Pane then shows 

the values for the selected 

row(s) only, here coconut. 

View food/ingredients tree button 

You cannot open reference foods. 
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4. To view the values for a specific nutrient in the Food/Ingredient Tree dialog: In 
the Analysis Pane, click that nutrient.  

Example 

 

  

Select a nutrient— 

here Saturated fat—-

in the Analysis 

Pane... 

...This column 

appears showing the 

nutrient per item. 
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Exploring where a recipe is used  

A recipe might be used in other documents in your database—either as an ingredient in 
another recipe or as an item in a dietary intake. 

To see what documents in your database use this recipe: 

1. In the Navigation Pane, navigate to the recipe and select it. 

2. At the bottom of the Navigation Pane, a box appears at the bottom showing you 
where this recipe is used. 

Example showing the ‘used in’ box 

 

3. As elsewhere in the Navigation Pane, simply click the document containing the 
recipe to open it to see how it is used.  

Look here in this box to see 

in what documents (and in 

what quantity) the open 

recipe or food is used. 

In this example, 2 serves of 

Tuna Filling is used in Tuna 

sandwich 
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9. Adding a new food  

This chapter explains how to add foods to your database. For example, you might 
choose to add a food that you cannot find in the reference foods. 

Icon Document Usage 

 

(yellow 

pear) 

Food Use for foods that you need to add to the database. 

Contrast the foods that are FoodWorks documents with reference foods from the data 
sources, which you can not open or edit:  

 Item Usage 

 

(pear on 

page) 

Reference 

food from data 

source 

Select reference foods to enter into your dietary intakes and recipes. Reference 

foods have nutrient values provided. They are not FoodWorks documents—you 

cannot open and modify them. 

 

Foods are FoodWorks documents and are stored in your FoodWorks database. You 
open them from the Navigation Pane. For more on FoodWorks documents, see What is a 
document? on page 17. 

When adding a new food, you need the nutrition information for the food. You can get 
this information by basing the food on a similar reference food. Or, you might have the 
nutrient values from the product label. You can also use a mixed approach basing the 
nutrition information on a reference food in FoodWorks, and then overriding those 
nutrient values for which you have more specific data available. 
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Adding a food  

To add a food to your FoodWorks database: 

A. Create the new food 

First, create the new food: 

1. On the FoodWorks toolbar, click New, then click Food.  

 

2. On the General tab, in the Name box, type the name for the food.  

 

3. Optionally, enter your ID for the food. 
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4. Click the Folder drop-down button and select the folder in which you want to store 
the food. By default, there is one folder, Documents.  

  

5. If you want to create a new folder, click the ellipsis (…) button. 

 

6. On the toolbar, click the Save button. 

 

B. Base the nutrient values on an existing food  

Using the following steps, you can base the nutrient values on a reference food (from a 
data source in FoodWorks), or on another FoodWorks document in your database. 

If you want to type in values from an from an external source, skip to C. Enter or edit 
nutrient values page 60.  

To derive the nutrient values for this food from a reference food or another FoodWorks 
document: 

1. Click the Nutrients tab. 
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2. To the right of the Base Analysis On drop-down button, click the ellipsis (…) 
button. 

 

3. The Select Food/Recipe dialog is displayed.  

 

4. Type a few letters of your search term, and select the food you want to use from the 
list box on the left, and press Enter. 

If you wish to edit the nutrient values, use the next procedure. 

C. Enter or edit nutrient values  

Use this procedure to enter nutrient values for your food from an external source, such 
as the label for the product. 

You can also use this procedure, if necessary, to override some of the nutrient values 
derived from a reference food or FoodWorks document (see the last procedure). 

To enter nutrient values for a food: 
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1. On the Nutrients tab, on the left, click the category of nutrient that you wish to work 
with. 

 

2. In the Override column, type the value for the nutrient, then press Enter. 

NOTE: Units  

Be sure to use the appropriate unit for each nutrient in FoodWorks. You can see 
the unit beside the nutrient name in the Nutrient/Component column on the 
Nutrients page. For example sodium uses the unit mg, not grams. 

D. Save the food 

To save the food: On the FoodWorks toolbar, click Save. 

 

You have now added your first food to the FoodWorks database. You can see your new 
food document in the Navigation Pane of FoodWorks, and it is available for you to use as 
an ingredient when you are entering a recipe or as a food in your food records. 

Next steps  

Your food is now shown in the Navigation Pane of your database. And it is automatically 
listed for you to select as an ingredient in recipes or as a food in dietary intakes. 
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10. Exploring the reference foods 

The Query view lets you explore all the reference foods in your licensed data sources 
(as well as all the documents in the FoodWorks database). You click an item to display 
its nutrient composition. You can rank the search results based on a specific nutrient or 
component. 

For more on reference foods and the data sources which contain them, see About the 
food composition data on page 15 

The usual view of the FoodWorks window is onto your database and all its folders and 
documents. In contrast, the Query view gives you a view into your reference data 
sources. 

Basics—Using the Query view  

Here are the basic ways to work in the Query view.  In Figure 4, the boxes with letters A, 
B, C and so on, show the procedures detailed in Basic procedures on page 63. 

To display the Query view: Click the Query button on the FoodWorks toolbar. To return 
to the usual database view, click the Query button again. 

 

Figure 4—The Query View: Basics  

 

Query button on toolbar 

 

Click here to toggle between the 

Query view and the standard 

view of FoodWorks. 

F. To rank the 

foods by the 

selected 

nutrient, click 

one of the units, 

for example, 

100g,  Click 

again to reverse 

the  ranking. 

A. Select 

the data 

sources 

to search 

in. 

The Analysis 

Pane showing 

the analyses 

for the food 

selected in the 

search results. 

D. The search results. Select 

an item (here apple, dried) to 

see its analyses on the right. 

The search results are 

shown in this middle 

pane. 

E. In the Analysis 

Pane, select a 

nutrient to focus on 

(here Vitamin C). 

It is then shown for 

each food in the 

search results. 

B. To include your own 

documents in the search: 

select this checkbox. 

 

C. Type your search 

item here. 
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Basic procedures  

To search for foods in the Query view: 

A. Set up your search  

To find foods in selected data sources and/or in your open FoodWorks database: 

1. To show the Query view, on the toolbar, click Query. 

2. Under Search In, select or de-select data sources as required.  

3. If you want to include FoodWorks documents from your open database in the 
search, below the Search In list, select the Show documents from this database 
check box.  

B. Type in your search term  

To search for an item:  

• In the Search box, type part of the name of the food(s) or recipe(s) that you want to 
find.  

The search results are shown in the middle pane of the Query view. 

C. View analyses for a selected food 

To show the nutrient analyses for a food listed in the search results: 

• In the middle pane of the Query view, click the food.  

The nutrient values for that item are displayed in the Analysis Pane on the right of the 
Query view. If you see question (?) marks, it indicates that FoodWorks cannot calculate 
this value or that the value is missing in the data source. See A. Symbols in the analyses 
on page 75 for information on how to resolve question marks.  

D. Show a nutrient for all  foods l isted  

To show the value for a particular nutrient for all the foods listed in the search results:  

• In the Analysis Pane of the Query view, click the nutrient of interest. 

The nutrient column (with the nutrient name as its title) appears to the right of the 
results list.  

E. Rank foods by a nutrient  

To rank the foods in the search results by nutrient:  

1. To select the nutrient, in the Analysis Pane, click the nutrient of interest.  

2. In the middle pane, click the title of the column (the unit of analysis) by which you 
want to rank the results. You can order the foods by the nutrient value per: 

o 100g  

o 1MJ (the value for the quantity of the food or recipe that contributes 1MJ of 
energy)  

o 100gDW (the value for 100g of the food or recipe where all water has been 
removed, that is, on a 'dry weight basis')  

3. To change the order of the ranking (from ascending or descending, or vice versa), 
click the title of the column again. 
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Searching for foods high or low in a nutrient  

To search the data sources and/or your documents for a food high or low in a nutrient: 

1. Set up your search: Under Search In, select or de-select data sources as required. To 
include FoodWorks documents from your open database in the search, below the 
Search In list, select the Show documents from this database check box. 

2. If necessary, clear the Search box. 

3. In the Analysis Pane, click the nutrient of interest. 

Example—Clicking Calcium  

 

  

The tab in the Search results now displays the nutrient you have chosen, and the 
value for each item is shown.  

4. To order the results from least to most: In the search results, click the unit of 
analysis (e.g. per 100g). Then, click the unit of analysis again to order the results 
from most to least. 

If you want to show the ranked list for all the foods in the selected data sources, as 
in the following example, make sure you clear the Search box first. 

Here, the user has clicked on 

Calcium in the Analysis Pane... 

...the name of the selected 

nutrient is displayed in the tab 

and the values are shown for 

Calcium for each item. 
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Example—Ranking per 100g for Calcium, most to least 

 

 

The user has clicked 

on the 100g column 

title twice to list items 

from most to least for 

Calcium per 100g. 
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11. Printing and publishing 

This chapter explains your options for printing, publishing and sharing your FoodWorks 
data. 

Printing a document  

To print a FoodWorks document (such as a dietary intake, recipe or meal plan):  

1. Open the document.  

2. On the toolbar, click Print.  

 

The Print window is shown, with a preview of your document on the right: 

 

3. To set printing options such as the paper size, orientation and margins, click Print 
Options. Edit as required, then click OK.  

4. Click the report you wish to print.  

5. Click Print. 

TIP: Saving a document as a PDF 

         To save a document as a PDF, on the toolbar, click Print, then click Save As 
PDF. 

 

Modifying a report  

To see what is included in a report, or to modify what is included:  

1. Click Options, and select or de-select sections as required.  

2. Then click OK. 
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Example—Print dialog for a food record, 24 hour recall or meal plan 

 

 

Alternatively, you can publish the document to Microsoft Word and print from Word: 
see the next procedure below. 
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Publishing a FoodWorks document to Word  

FoodWorks has a publishing tool that enables you to streamline publishing your 
documents to Word. You can create Word templates appropriate for publishing your 
FoodWorks documents and use these templates whenever you publish to Word. 

To publish a FoodWorks document using Microsoft® Word: 

1. In FoodWorks, open the document. 

2. On the Tools menu, click Publish with Microsoft Word. FoodWorks now opens 
Microsoft Word and Word displays the templates for you to choose from.  

3. Click the template in Word that you want to use. 

4. The Word document opens, and the FoodWorks Publish with Microsoft Word tool 
appears: 

FoodWorks Word Publisher tool (for recipes) 

 

5. In the Word document, place the cursor where you want the data to appear, then on 
the Publish with Microsoft Word tool, click the button for the type of data you 
want to insert. 

6. Repeat step 5 until you have entered all the data you require. 

7. Format the Word document as you require. 
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TIP: Save your Word document as a Word template  

Open the Word document to which you have published FoodWorks data that you 
would like to use as a template. On the File menu, click Save As. Click Browse, then 
from the Save as type menu, select Word Template (*.docx), enter a file name and 
click Save. 

To use your template, when you next go to publish from FoodWorks to Microsoft 
Word, in Word, click the Personal tab, and you should see your saved template. 

 

Emailing a FoodWorks database  

To email your database to another FoodWorks user, on the File menu, click Send 
Database To and choose Mail Recipient. 

Or simply attach your FoodWorks database to an email.  

To open a database that you receive by email: 

1. Save the attachment. 

2. In FoodWorks, on the File menu, click Open FoodWorks Database File, then 
navigate to the database file, and click Open. 

Importing folders from another FoodWorks database  

To import FoodWorks documents from another FoodWorks database:  

1. On the Tools menu, click Import, then click From FoodWorks Database.  

 

2. Open the Windows folder containing the FoodWorks database from which you wish 
to import.  

3. Select the database file to open, then click Open. 

4. Select the FoodWorks folders that contain the documents you wish to import.  

5. Click Import. 
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Publishing your foods and recipes as a data source  

If you want your recipes and foods to be available as reference foods (with nutrient 
composition) to other FoodWorks users, you can publish your FoodWorks database 
(just the recipes and foods) as a FoodWorks data source. 

To publish the data from your FoodWorks database as a data source for other 
FoodWorks users: 

1. Open the FoodWorks database. 

2. On the Tools menu, click Publish as FoodWorks Data Source. 

 

NOTE: About publishing a data source 

When you publish your data as a FoodWorks data source, it is automatically 
available to you and other users on this computer.  

If you are working on a local area network where multiple users are accessing the 
same FoodWorks databases, it is recommended that, prior to publishing, you place 
the database in the same folder as the databases that will use the new data source. 
Then, when you publish your database as a data source, the new data source is 
automatically available for other users on the local area network. 

If you want to send this data source to other users, first, you need to compress the 
data source into a FoodWorks cabinet file. Then you can email it, post it to a web site, 
or copy it to a shared folder.  
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3. Follow the instructions shown. You can choose which folders (of recipes and foods) 
to publish. 
 

  

4. Then Under Show Advanced Options, you can choose:  

• which nutrients to publish 

• whether to compress the exported file into a FoodWorks cabinet file (.FWC) 

 

Install ing a FoodWorks data source  

To install a FoodWorks cabinet file (extension .FWC) containing a FoodWorks data 
source: 

1. On the FoodWorks Tools menu, click Install Data Source. Alternatively, double-
click the cabinet file containing data source. 

 

2. Follow the instructions shown.  

TIP: Checking that the data source is installed 

         To check that the new data source is installed: Open the FoodWorks database 
that is to use the data. Click File, then click Database Properties. Click Food 
Selections and the new data source will be listed.  

 
  

NOTE: Sending a FoodWorks data source 

If you want to send this data source to other users, make sure that you select Create a 
FoodWorks Cabinet file.  
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Exporting your data for further analysis  

You can export your data to Microsoft Access for further analysis in other software such 
as a statistical package. 

To export data from a FoodWorks database to Microsoft Access: 

1. Open the FoodWorks database. 

2. On the Tools menu, click Export. 

 

3. Follow the instructions shown. 

FoodWorks creates a new Microsoft Access database containing the data from your 
FoodWorks database, in the location that you specify. You can then use Microsoft Access 
or any other compatible tool to query, analyse or produce reports on the documents in 
your database. 
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12. Importing diaries from Easy Diet Diary  

Users of Easy Diet Diary (our mobile app for iPhone and Android phones) can send their 
diary to you to open and analyse in FoodWorks. When a client chooses to share their 
diary with you, you receive a link to download their diary in an email we send to you on 
behalf of your client.  You can open their diary in FoodWorks straight away, or you can 
save the file for use later.  

More information  

For more about Easy Diet Diary, visit easydietdiary.com. To download Easy Diet Diary, 
visit the Apple App store or the Google Play Store and search for ‘Easy Diet Diary’.  For 
help for your clients in using Easy Diet Diary, including how to email their diary to you, 
visit the Easy Diet Diary support site: support.easydietdiary.com.   

Opening a diary in FoodWorks from the email  

To open a diary in FoodWorks:  

1. Locate the email sent by us on behalf of your client and click the “Open in 
FoodWorks” button.  

2. Depending on the settings of your web browser. The Easy Diet Diary file will either 
be automatically downloaded (usually in the Downloads folder), or you will be 
prompted to save the file to suitable location.  

3. To open the diary in FoodWorks, double-click the downloaded file.  

By default, the diary is automatically imported into a database, EasyDietDiary.fwb in 
the Documents folder. See below if you want to open the diary in a different FoodWorks 
database.  

Set the default destination database  

If you wish, you can set another database and location as the default database for Easy 
Diet Diary diaries.  

To set the FoodWorks database to which you want to import diaries from Easy Diet 
Diary:  

1. Open the database to which you want to import the diaries.  

2. On the Tools menu, click Options.  

3. On the General tab, tick the checkbox: 'Make this database the destination for EDD 
diaries.' 

4. Click the OK button. 

  

https://xyris.com.au/products/easy-diet-diary/
https://support.easydietdiary.com/hc/en-us
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Opening a diary from within FoodWorks  

If you are working in FoodWorks, you can also import the diary into your currently 
open database.  

To open the diary in the currently open database:  

1. First, from the email, save the diary in a suitable location.  

2. On the Tools menu, click Import, then From Easy Diet Diary File.  

 

3. Navigate to the Easy Diet Diary file.  

4. Click Open.  

Tips  

• Recipes: Recipes imported from the diary are shown in blue. To see the ingredients, 
click right on the recipe name, then click Open. The quantities of the ingredients are 
shown for the whole recipe; the portion eaten is shown as a percentage of the whole 
recipe. (To see the recipes as documents in their own right, in the Folder box, click 
right and select Show Hidden Folders.) 

• Exercise: Exercise activity from the diary is shown at the bottom of the list of foods 
for each day.  

• Personal details: Your client's details from Easy Diet Diary such as age, weight and 
height are shown in the General tab.  
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A. Symbols in the analyses  

Sometimes in the Analysis Pane, instead of numbers you will see question marks (?) for 
one or more or all the nutrients. Or you might see a > (‘greater than’) sign in front of one 
or more value. A question mark indicates that for some reason FoodWorks cannot 
calculate a nutrient value. When only a partial result is possible, FoodWorks displays 
the ‘greater than’ sign before the partial result. 

Example recipe with question marks in Analysis Pane 

 

Causes of question marks and ‘greater than’ signs  

Question marks (?) and ‘greater than’ (>) can be caused by missing data. 

The data might be missing from a FoodWorks document. It might be that you omitted 
some data on the Foods tab (for a food record) or Ingredients tab (for a recipe) or the 
Nutrients tab (for a food). In the recipe above, for example, a quantity has been omitted 
for an ingredient.  

Or the data might be missing in a reference food. 

Sometimes a calculation is impossible. For example, if you are investigating protein, for 
water, the percentage of energy from protein appears as a question mark because the 
calculation 0/0 is undefined. 

Investigating question marks and ‘greater than’ signs  

Here are some suggestions for investigating question marks or ‘greater than’ signs 
appearing in the Analysis Pane of a dietary intake or recipe. 

Find the problem items  

1. Depending on whether you have open a dietary intake or recipe, click the Foods or 
Ingredients tab. 

Question marks (?) in 

the Analysis Pane. 
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2. In the Analysis Pane, click a nutrient showing a question mark or ‘greater than’ sign. 
A column appears on the right side of the foods/ingredients grid showing values for 
this nutrient. There will be question marks beside the problem items.  

Example recipe 

 

If  all  foods have question marks or ‘greater than’ signs  

If all foods in the dietary intake or recipe have a question mark or ’greater than’ sign for 
a nutrient, there might be a global problem with the dietary intake or recipe. For 
example, for a recipe, check that a valid value been entered for the yield.  

Check a valid quantity had been entered  

In the foods/ingredients grid, check that a quantity for the problem item has been 
entered. If it is missing, enter the quantity and click Save.  

Open a problem FoodWorks document  

If the problem item is a FoodWorks document (food or recipe): 

1. In the foods/ingredients grid, right-click it, then click Open. (Remember you cannot 
open a reference food.) 

The dietary intake or recipe might have nested recipes within it. 

2. To make sure you can see all the FoodWorks documents and reference foods that 
the dietary intake or recipe contains: On the FoodWorks toolbar, click the View 
Foods/Ingredients tree button.   

3. To open the problem FoodWorks document (food or recipe) from the 
Food/Ingredient tree dialog, double-click it.  

Investigate a problem FoodWorks document  

To investigate the problem FoodWorks  document  (food or recipe): Open the 
document, then click the Nutrients tab (for foods) or Ingredients tab (for recipes) tab 
and check for missing data. Enter any required data and click Save.  

The user has clicked on 

Protein in the Analysis Pane to 

bring up this column. The 

problem food is Mixed 

Vegetables. 
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Investigate a problem reference food 

To investigate a problem reference food:  

1. Find out the data source it comes from—this data source might not contain values 
for this nutrient: In the foods/ingredients grid, click the name of the food, then press 
F2. The data source for the reference food is shown at the bottom of the food 
selection list.  

2. If the reference food does not have the nutrient data you need, your options include 
to:  

• Create your own food. 

• Disable the nutrient for this database—On the File menu, click Database 
Properties, then click Nutrients & Components, then de-select the nutrient 
and click OK. 
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B. Using keywords for selecting foods 

This appendix explains options that you can set for the food selection list used when 
selecting foods or ingredients for a food record or recipe. 

 

 

To show the food selection list at any time: Click the Foods or Ingredients tab of the 
food record or recipe document. Click in the Food or Ingredient column and start 
typing, or simply press F2. 

Using keywords in the food selection list  

In the food selection list, you can turn on keywords to help guide you through the list of 
foods.  

To turn on keywords: 

1. At the bottom of the food selection list, click Options. 

2. Then click Show Keywords. 

 

The food selection list. 
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Now instead of a flat list of foods matching the letters you have typed, the list shows 
categories of foods.  

Example of food selection list without keywords 

 

Example of food selection list with keywords turned on 

 

 

To find the food you want using the keywords:  

1. Use the arrow keys or the mouse to select the keyword, then press Enter.  

2. Continue until you find the actual food item to select — it will have an icon beside it 
and will be a recipe, food or reference food.  
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Example of food selection list with reference food 

 


